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CAUTION!

AFT Arrow is a sophisticated pipe flow analysis program designed for
qualified engineers with experience in pipe flow analysis and should not
be used by untrained individuals. AFT Arrow is intended solely as an aid
for pipe flow analysis engineers and not as a replacement for other
design and analysis methods, including hand calculations and sound
engineering judgment. All data generated by AFT Arrow should be
independently verified with other engineering methods.

AFT Arrow is designed to be used only by persons who possess a level
of knowledge consistent with that obtained in an undergraduate
engineering course in the analysis of pipe system fluid mechanics, have
been trained in the specialized field of gas dynamics, and are familiar
with standard industry practice in pipe flow analysis.

AFT Arrow is intended to be used only within the boundaries of its
engineering assumptions. The user should consult the AFT Arrow
internal help files for a discussion of all engineering assumptions made
by AFT Arrow.

Information in this document is subject to change without notice. No part of this Quick
Start Guide may be reproduced or transmitted in any form or by any means, electronic or
mechanical, for any purpose, without the express written permission of Applied Flow
Technology.

© 2020 Applied Flow Technology Corporation. All rights reserved.

Printed in the United States of America.

"AFT Arrow", "Applied Flow Technology", “Dynamic solutions for a fluid world”, and
the AFT logo are trademarks of Applied Flow Technology Corporation.

Windows is a registered trademark of Microsoft Corporation.
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CHAPTER 1

Introducing AFT Arrow ANS Module

Welcome to the AFT Arrow™ ANS module, Applied Flow Technology's
powerful pipe and duct system automated sizing tool. With the ANS
module you can automatically size all pipes or ducts in a system to
minimize monetary cost, weight, volume, or surface area. In addition,
you can concurrently size the compressors or fans and pipes to obtain the
absolute lowest cost system that satisfies your design requirements.
Finally, by including non-recurring and recurring costs, you can size pipe
and duct systems to minimize life cycle costs over some specified
duration.

How AFT Arrow ANS module works

The AFT Arrow ANS module consists of three basic elements: the
Graphical Interface, the Compressible Flow Solver, and the Automated
Sizing Engine. Figure 1.1 shows the relationship between the three.

Graphical Interface

Input I Qutput

Compressible
Flow Solver

Automated Sizing I

Engine

Figure 1.1 AFT Arrow ANS module main component flow chart
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The Compressible Flow Solver obtains a balanced flow solution for a
specific pipe or duct system. The Automated Sizing Engine then
modifies the design, and the Compressible Flow Solver evaluates the
modified design. The Automated Sizing Engine continues this process
until it is satisfied that no further design improvements are possible. At
this point, the Automated Sizing Engine has converged on a design, and
the resulting sized design is then sent back to the Graphical Interface
where it is displayed to the user.

The Compressible Flow Solver, which functions as the prime mover in
performing an engineering analysis (e.g., AFT Arrow ™), becomes a
subroutine called by the Automated Sizing Engine. The Automated
Sizing Engine is the prime mover in AFT Arrow ANS module.

The Automated Sizing Engine employed by AFT Arrow ANS module
uses state-of-the-art numerical searching technology licensed from a
leading developer in this field. This technology has been used for many
years in engineering design, with extensive use in structural finite
element analysis.

Analysis vs. design

Analysis

Traditional piping system engineering has employed pipe flow analysis.
Engineering analysis is the process of using accepted calculation
methods to predict the behavior of a given system. These calculation
methods may be manual, or automated in a computer program.

The weakness of analytical methods for design is that they require the
specification of the system before the methods are applied. Specifically,
the pipe or duct sizes, compressors, valves and other equipment must be
specified in order to perform the calculation.

However, when a new pipe system is being designed, these parameters
are not known. To use the analytical methods, the engineer must guess at
the pipe sizes and required equipment, perform the analysis, then modify
his or her original selections as necessary.

The analytical methods are used iteratively to arrive at a final design.
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Design

A design-oriented approach to piping system engineering would allow
the selection parameters to be variables. Rather than specifying pipe
diameters, the engineer solves for pipe diameters by specifying the flows
and pressures (and other design requirements) and using these to select
the appropriate pipes which minimize the overall system weight, volume
or monetary cost,

Within certain limits engineers do this with traditional analytical
methods, but the number of design tradeoffs that can be considered is
limited and the tradeoffs considered are indirectly tied to weight, volume
or monetary cost,

The ANS module offers a true design-oriented approach to piping system
engineering by using advanced automated sizing methods to evaluate
competing designs vs. weight, volume or cost, and select the best design.
The analysis method (i.e., the Compressible Flow Solver) is called
repeatedly by the ANS module in an effort to identify design
improvements (i.e., improvements that reduce weight, volume or
monetary cost).

Weight, volume and monetary cost are all costs

In the English language we usually associate the word “cost” with
money. However, in engineering, that does not have to always be the
case. If an engineer is designing an aircraft, for example, minimizing
weight is essential. In that respect extra weight is a “cost”.

To simplify discussion in this guide, and to avoid needless repetition, the
word “cost” will be used to represent any of the parameters an engineer
may wish to minimize. In the ANS module this can be weight, volume,
surface area or monetary cost. When discussing issues specifically
related to monetary cost, the words “monetary cost” will be used unless
the context is otherwise clear that the discussion refers to “monetary
cost”,

Cost-based automated sizing vs. cost estimating
The ANS module is not a cost estimating tool. Rather, it offers a rational

and automated approach for comparing potential pipe or duct system
designs using the common denominator of cost. It is the pipe or duct
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system design that the ANS module obtains that is of immense value, not
the process of cost estimating.

AFT Arrow ANS module design capabilities

The AFT Arrow ANS module can be used to size a wide variety of
engineering systems.

Types of systems that can be sized
e Piping, ducting and tubing systems
e Open and closed (recirculating) systems

e Network systems that branch or loop, with no limit on the number of
loops

e Pressure-driven systems

e Compressor or fan-driven systems, including multiple
compressor/fans in parallel or in series

e Compressors/fans with variable speed, controlled pressure, and
controlled flow

e Systems with pressure and/or flow control valves

e Systems with valves closed and compressor/fans turned off
e Heat transfer analysis and system energy balance

e Systems with non-ideal gasses

e Systems that experience sonic choking, including multiple sonic
choking points

e Systems with non-reacting flow streams mixing and user-defined
mixtures

e Systems with elevation changes or rotation such as in
turbomachinery

Types of automated sizing parameters available
e Pipe/duct size

e Pipe velocity, pressure gradient, pressure, and flow
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e Compressor/fan pressure rise, proximity to BEP (Best Efficiency
Point), power, and others

¢ Control valve pressure drop and open percentage

AFT Arrow ANS module primary window

When the ANS module is activated in AFT Arrow several changes are
made to the interface, though the main impact is the addition of a sixth
Primary Window, the Sizing window. The Sizing window allows for the
sizing and (optionally) cost settings to be configured for the model.
When the model is set to perform sizing, input information in the
Workspace and Model Data windows for the components being sized are
used as initial guesses. Components which are not being sized are treated
as constants for the automated network sizing.

Automated sizing terminology

General automated sizing terminology applied to pipe systems is as
follows:

Design requirements

There are numerous design requirements in the ANS module. Common
requirements are pipe velocity, control valve pressure drop and proximity
to compressor/fan BEP (Best Efficiency Point).

Active and inactive design requirements

An active Design Requirement is a requirement which has a direct
impact on the solution, whereas an inactive Design Requirement is a
passive requirement which does not impact the solution. If an active
requirement is removed, the ANS module will find a different solution,
whereas removing an inactive requirement will not affect the solution.

Consider a case where several Design Requirements are set for the
velocity in a pipe. One may set the maximum to 30 m/sec, and the
minimum to 3 m/sec. If the final pipe velocity were 29 m/sec, the
maximum velocity Design Requirement would be active because the
final value of the velocity is at or near the maximum velocity. On the
other hand, the 29 m/sec pipe velocity is far away from the 3 m/sec
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minimum. If we remove the minimum velocity Design Requirement, the
result will still be an actual pipe velocity of 29 m/sec. Thus, the
minimum velocity Design Requirement is inactive and does not
influence the selected pipe size. On the other hand, if one removed the 30
m/sec maximum velocity Design Requirement, the actual velocity would
probably increase above 30 m/sec, thus resulting in a different pipe size.

Objective

This is the goal of the analysis. Typically, the objective is to minimize
monetary cost either directly using monetary cost data, or indirectly by
minimizing parameters such as pipe weight. As the ANS module varies
the pipe sizes, the objective parameter (cost, weight, etc.) varies. The
Automated Sizing Engine searches for combinations of pipe sizes that
achieve the objective by comparing these variations.

Continuous vs. discrete sizing

Discrete data is a set of data which lists explicit values which can be
used, such as a set of pipe sizes within a given schedule. Continuous data
is a set of data which can include any values within the given minimum
and maximum, such as with percent open values for a valve.

Generally the desired sizing within the ANS module is discrete, since
commercial pipe sizes must be chosen from a set of specific sizes.
However, since it is much easier to minimize values using a continuous
solution, many methods in the ANS module will first implement
continuous sizing, then use this solution to find a nearby discrete solution
for the system. Note that this is not as simple as just choosing the closest
discrete value around the continuous minimum. Good searching
algorithms like those used in the ANS module will consider values more
than one discrete size from the continuous value.

Common size groups

The automated sizing process takes longer as the number of pipes being
independently sized increases. Frequently there are groups of pipes in a
system which would ideally be the same size for design purposes, or
must be the same size by virtue of their location in the system. To link
the sizes for pipes together one can create Common Size Groups. When
one places pipes into a Common Size Group, one is saying that the group
of pipes all must have the same pipe size, and be the same material and
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schedule, class, or type. A Common Size Group thus consolidates the
individual pipes that are part of that group to a single independently sized
pipe for that group. There can be multiple Common Size Groups in a
model, but each pipe can only belong to one Common Size Group.

Feasible and infeasible designs

A feasible design is one which satisfies all Design Requirements, while
an infeasible design does not satisfy one or more Design Requirements.
There are many ways you can create a model that has no feasible
solution. For example, connect a pipe to an Assigned Pressure junction
set to 14 bar. Then place a Design Requirement on the pipe that it cannot
have a pressure greater than 7 bar. Since the pipe is connected to an
Assigned Pressure junction at 14 bar, there is no way for it to satisfy the
7 bar Design Requirement. Thus, no feasible solution exists.

Candidate sets

A Candidate Set is a collection of potential sizes that will be considered
for the sizing calculations. Each pipe being sized in the system must have
one Candidate Set assigned to it. If continuous sizing is being performed,
only the minimum and maximum pipe sizes in the Candidate Set will be
used to bound the continuous sizing.
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CHAPTER 2

Weight Sizing Example

This example shows how to use the ANS module to perform a non-
monetary automated sizing on a system. Parameters such as pipe weight
or flow volume frequently relate closely to the actual pipe cost, and are
easier to set up than cost based automated sizing. This makes them useful
for an initial estimation. Further, on some systems such as aircraft,
marine vessels or automobiles, minimizing weight may be the primary
goal.

This example demonstrates minimizing the pipe weight in a system.

Topics covered

e Non-monetary parameter automated sizing
e Creating Common Size Groups
¢ Defining Candidate Sets

e Control Valve Design Requirements

Required knowledge

No prior knowledge is required for this example. However, users who
are completely new to AFT Arrow are advised to first complete the AFT
Arrow Quick Start Guide examples. There one will see how to use basic
features for conventional pipe flow modeling. This example focuses on
the automatic sizing features in the ANS module.
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Model file

This example uses the following file, which is installed in the Examples
folder as part of the AFT Arrow installation:

e  Meiric — Control Valve — ANS.aro — AFT Arrow model file

This example is provided in English units under the US — Control Valve -
ANS.aro .

This example will require you to build the model from scratch to help
familiarize yourself with the steps required to build a complete model in
AFT Arrow. Therefore, use this example model file as a reference only.

Problem statement

The example is for a steam transfer system that feeds steam from a
pressurized tank to a lower pressure tank. A control valveis used to
control the flow rate to 4540 kg/hr and must have a minimum pressure
drop of 140 kPa. We will locate the flow control valve at the midpoint of
the 80 meter pipeline.

The pipeline is limited to STD (schedule 40) Steel - ANSI pipe in the
size range from 1-10 inches.

Step 1. Start AFT Arrow

From the Start Menu, choose AFT Products and AFT Arrow,

Activate the ANS module from the Startup Menu by checking the box
next to the ANS module. Alternatively, the ANS module can be activated
from the Module button at the bottom of the Quick Access Panel, or from
the Activate Modules option in the Tools menu.

Once the ANS module has been activated check that it is enabled for use
by going to Automated Sizing under the Analysis menu and selecting
Network as shown in Figure 2.1. This should be done automatically by
AFT Arrow when the module is activated.
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Figure 2.1 Enabling the ANS module for use. The Automated
Sizing option becomes available when the ANS
module has been activated.

Step 2. Specify system properties

1. Open the System Properties window by selecting System Properties
in the Analysis menu.

2. On the Fluid Data tab, select the AFT Standard database and then
select “Steam” in the Fluids Available in Database list.

Click “Add to Model” to select steam for use in this model.
4. Click OK.

Step 3. Build the model

A. Place the pipes and junctions

At this point open the Checklist. The Checklist can be accessed by
clicking the checkmark icon on the toolbar, or from the Tools menu, and
provides a summary of items that must be completed before the model is
run. When the ANS module is activated the fourth checklist item changes
from “Specify Cost Settings™ to “Define All Sizing Input”.

For this model the first two items have been completed. The next
Checklist item is to “Define All Pipes and Junctions™, In the Workspace
window, assemble the model as shown in Figure 2.2.
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Figure 2.2

B. Enter the junction data

J1 - Tank
1. Elevation=0m

2. Pressure = 1725 kPa
3. Temperature = 315 deg. C

J2 - Control Valve
1. Elevation=0m

Control Valve system layout

2, Valve Type = Flow Control Valve (FCV)

3. Mass Flow Rate = 4540 kg/hr

J3 - Tank
1. Elevation=0m

2. Pressure = 1380 kPa
3. Temperature =315 deg. C

H =2 @3
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C. Enter the pipe data

For this example, we need to find the best pipe size, but we are limited to
STD (schedule 40) pipe sizes. Now we need to use engineering judgment
to take an initial guess at the pipe size for a flow rate of 4540 kg/hr. Let’s
try 6 inch pipe. Specify both pipes as follows:

Pipe Material = Steel — ANSI
Size = 6 inches

Type = STD (schedule 40)
Length =40 m

Friction Model = Standard

I I

Step 4. Define sizing input

The first three items have now been completed on the Checklist, leaving
one last item to “Define All Sizing Input”.

In this model we are going to perform sizing to minimize the pipe
weight, while maintaining a minimum pressure drop of 140 kPa across
the control valve. To do this, first go to the Sizing window by clicking on
the Sizing tab, or from the Window menu.

The Sizing window is comprised of multiple panels which can be
accessed using the buttons on the Sizing Navigation Panel along the
bottom of the window, as shown in Figure 2.3. The sizing panels can be
accessed in any order, though it is easiest to enter the information by
navigating the panels from left to right, since the input on panels such as
the Sizing Objective and the Sizing Assignments panels will affect the
options available on later panels. Depending on the type of sizing being
done, some panels may be disabled or unused.
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Figure 2.3 Sizing window layout identifying common features

Similar to the Checklist, each panel button contains either a green
checkmark or red circle which denotes the completion status of that
panel. If the minimum required information is present to run the model,
the symbol will be green, whereas the red symbol represents incomplete
input. The amount of information required will vary based on whether
the sizing calculation is set to Perform Sizing, Calculate Weight/Do Not
Size, or Do Not Size. A detailed summary of the items which have been
completed and the items which are still incomplete can be seen in the
Sizing Status window, accessed from the Checklist.

The type of sizing calculation being performed, also called the Sizing
Level, can always be seen on the Sizing Level Status Box on the left of
the Sizing Navigation Panel as shown in Figure 2.3. Clicking this box
will bring you to the Sizing Objective panel, where the calculation type
can be changed. The choice of continuous or discrete sizing is selected
on the Sizing Method panel, which is discussed later.

Note that some panels, such as the Design Requirements panel, will
always be shown as complete since the model can be run without any
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v

additional information entered on them. However, in order to find the
best system design it will often be necessary to enter more than the
minimum information required by the Solver.

The Lock Panel toggle located on the Sizing Toolbar prevents changes to
the current panel when it is enabled. This is primarily useful to prevent
editing once a scenario has been run, since any changes that are made to
a scenario which has output will cause all output to be erased. By default,
all panels will lock after a sizing run is completed, requiring panels to be
unlocked before any changes can be made. This setting can be changed
on the Sizing Objective panel. All panels can be locked or unlocked
simultaneously by using the Lock/Unlock All Panels buttons on the
Sizing Toolbar.

A. Sizing objective

The Sizing Objective panel will be displayed by default when the Sizing
window is first opened, as shown in Figure 2.3. This panel is used to
select the option for calculation and to set the desired Objective.

The first option is "Perform Sizing", which sets up the model to perform
the automated sizing calculation. While it is typically desired to run the
sizing calculations, the other two selections can be useful in certain
cases.

The second option is "Calculate Weight, Do Not Size". This option is
similar to running AFT Arrow with the Cost Analysis option turned on
and is useful to find the cost of the initial design, or for troubleshooting.
By default, the cost for the model is calculated in terms of weight.

The last option is "Do Not Size". This is equivalent to performing a
regular AFT Arrow analysis without needing to disable the ANS module
and potentially lose the entered Sizing settings. This can also be useful to
check the feasibility of the initial design before sizing.

Select “Perform Sizing” to begin configuring the sizing run.

The next step is to set a Sizing Objective, which can be monetary cost, or
a non-monetary cost such as pipe weight or flow volume. It is easier to
perform a non-monetary sizing, since all of the geometry and material
information necessary to calculate the pipe weight/volume is already
contained in the pipe material databases. A monetary cost objective
would require cost information to be obtained and entered into cost
databases. For many systems, sizing the system using one of the simpler
non-monetary objective options provides a sufficient approximation for
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monetary cost. In this case, we will be performing a minimization for
pipe weight.

For the Objective choose "Pipe Weight" and select the Minimize
option from the drop-down list.

B. Sizing assignments

On the Sizing Navigation Panel select the Sizing Assignments button.
The Sizing Assignments panel allows the user to define what will be
sized in the model, and what will be included in the cost calculation
without being sized (in this case, what will be included in the weight, but
will not have its weight minimized). Common Size Groups for pipes can
be created on this panel as well when appropriate.

The Sizing Assignments panel can be used to select various options to
either “Automatically Size”, or “Do Not Size™ each pipe.

If an “Automatically Size” option is selected, the ANS module will treat
the pipe diameter as a variable and vary it according to certain criteria
that will be discussed shortly.

In a new system, typically all pipes will be desired to be sized and
included in the cost calculation (in this case, the cost is being calculated
in terms of weight). If you are instead analyzing the possible replacement
of existing pipes, it may be better to choose “Include in Weight if Size
Changes”. This will allow the weight to only be calculated for pipes if
they change size, since using the existing pipes will incur no new costs.

If “Do Not Size” is selected, the pipe will retain the settings currently set
in the Workspace. Why would one choose to not size a pipe? There could
be a number of reasons, but one good reason is that the pipe represents a
pipe in an existing system and the design does not allow the replacement
of that pipe with a new one. Therefore, its diameter is fixed, and sizing
the pipe would be incorrect.

Another reason may be if a certain size is necessary for the design due to
specific requirements, in which case the pipe cost can be included
without sizing the pipe by choosing “Include in Weight”.

This model is a new system, so all pipes will be sized and included in the
cost (weight).

Select " Always Include in Weight" next to each of the pipes.
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For this system it is required that both pipes be the same size. We will
need to add both pipes to a Common Size Group to specify this as
follows:

1. Click the "New" button above Pipe Grouping, and specify a name
(e.g. Main Pipes)

2. A new section will now appear with the Main Pipes group listed
under Common Size Groups. Add both pipes to this group by
clicking the corresponding radio buttons (Figure 2.4).

Now that the pipes are both in a Common Size Group, the ANS module
will force them to have the same diameter, rather than allowing them to
be varied separately.

For larger models, multiple Common Size Groups can be created as
desired. Selection tools are available at the bottom of the window to help
assign multiple pipes to a Common Size Group at once. Pipes can only
be assigned to a group once they are set to use one of the “Automatically
Size” options.

/" Workspace | & Sizing | [AModelDate | [JOutput | I Graph Results | ® Visual Report |
¥ Undo ~ ~w Redo

[@ Poes’

< & LockPanel 8 Lock All Panels &5 Unlock All Panels 5] Show Status Panel

Sizing Assignments

Move to:

Candidate Design
5 Requirements

Figure 2.4 Pipes P1 and P2 settings in the Sizing Assignments
panel
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C. Candidate sets
Click on the Candidate Sets button to open the Candidate Sets panel.

To select a specific pipe size, the ANS module first needs a list of
potential sizes from which to choose. This list is called a Candidate Set.
A specific pipe can only access one Candidate Set, but a specific
Candidate Set can be accessed by any number of pipes.

The Candidate Sets should include both smaller and larger pipes than
your anticipated final size to avoid limiting the sizing unnecessarily. If
you make the Candidate Set too small, you may limit the ability of the
ANS module to find the best sizing. It is better to make the Candidate Set
too large than too small. Experience applying the ANS module to actual
systems will help you choose appropriate Candidate Sets. If after
obtaining a solution you find that one or more of the sized pipes is at the
extreme of the Candidate Set, a warning will appear and recommend that
the defined Candidate Set be expanded.

To create a Candidate Set, do the following:

1. Under Define Candidate Sets, click the New button.

2. Give the set a name (e.g., "STD Pipes") and click OK.
3. From the drop-down list choose Steel - ANSI.
4

In the bottom of the Select Pipe Sizes window, check that the Sort
option "Type, Schedule, Class" is selected.

5. Inthe Available Material Sizes and Types on the left, expand the
STD pipe sizes list.

6. Double-click each of the sizes from | to 10 inches to add them to the
list on the right or use the “add” button (Figure 2.5).

7. Click the OK button.
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Select Pipe Sizes
Candidate Set Name: STD Pipes Materal:  Matedal Name
Steel - ANSI v
Avalable Matesal Sizes and Types ‘Bl B ¥ Use These Sizes and Types n Canddate Set
=-STD A 1inch, STD (schedule 40)
—_— 1-1/4 inch, STD (schedule 40)
4inch 1-1/2inch. STD (schedule 40)
2inch. STD (schedule 40)
3/Binch 2-1/2inch, STD (schedule 40)
1/2inch 3inch. STD fschedule 40)
Vdinch 31/2inch, STD (schedule 40)
~firy 4inch, STD (schedule 40)
% Add> | |Sinch, STD (schedule 40)
11/4inch 6inch, STD (schedule 40)
1-1/2inch 8inch, STD (schedule 40)
2inch 10inch. STD (schedule 40)
2-1/2inch
3inch
31/2inch
| . dinch v
Sort Al | None | invet Delete
O Standard
(®) Type, Schedule, Class
« OK E3 Cancel D Hep

Figure 2.5 Select Pipe Sizes window with STD Steel-ANSI pipe
sizes added for 1”-10” schedule 40

The "STD Pipes" candidate set will now appear. However, we still need
to define which pipes will use this Candidate Set during the automated
sizing. By necessity, a Common Size Group will use one Candidate Set
for all pipes within the group, since all pipes in the group must be the
same size. In this case there is only one item fo assign the set to.

» Under Assign Candidate Sets to Pipes, set the ""Main Pipes"
Common Size Group to use the "STD Pipes" Candidate Set. The
Candidate Sets are now fully defined and assigned to the appropriate
pipes, as can be seen in Figure 2.6.

Once a Candidate Set is selected, the list of available pipe sizes on the
Pipe Properties window in the Workspace is restricted to pipes in that
Candidate Set. In Figure 2.7 you can see the area normally described as
"Size" is now described as "Size (From Common Size Group)". If the
initially defined pipe sizes were not included in the assigned Candidate
Set, the ANS module will provide the option to change the pipes in the
Workspace to a pipe size from the defined Candidate Set when the model
is run.



20 AFT Arrow 8 ANS Module Quick Start Guide

7" Workspace | # Siing | [ Model Osta | [Output | I Graph Results | ® VisuslReport |1
of LockPanel 8 Lock All Panels 8" Unlock All Panels 1] Show Status Panel

() Define Candidate Sets
(== =]

Set Name [ Pipe Material

R ” Mo H o | lbzﬂ-rxﬁh&s:ldeﬁihsmﬁp-dnmhdmd:

Figure 2.6 Candidate Sets panel fully defined for the model

Pipe Properties
— — e , o]
M |I‘u V] Downstream Junction: 2 B Concel .
%Mﬁﬂhl | [Copy Previeus B = |
P ne

[ Pipe Model | Fitings &lLogses | Hest Transler | DesignAbers | Ogionsl | Meges | Sizas |

e rs

S R —
Ppe Geometry: Cylecical Ppe
Saw: Lﬂ
oe Ty
—— =

I << )leflelle

— -, - v
[ 10 Rechuction (Scaing): i
Frction Model
'B':: Hpsoite Roughness v [ LosdDefa |
© [ g bwen = -

Figure 2.7 Pipe Properties Window after having a Candidate Set
assigned to it — pipe size selections are limited to
those in the Common Size Group
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D. Design requirements

Select the Design Requirements button. This panel is used to define
restrictions on the final solution by applying Design Requirements for
the system.

For this model we only have one Design Requirement, which is for the
minimum pressure drop across the Control Valve. To define this
requirement:

1. Select the Control Valves button at the top of the window.

2. Click the New button under Define Control Valve Design
Requirements.

Enter a name when prompted (e.g., "Min Pressure Drop").

4. Next to "Min Pressure Drop” in the table, select Pressure Drop Static
as the Parameter.

5. Choose Minimum for Max/Min, and enter 140 kPa

Now that the Design Requirement is defined, it needs to be assigned to
the appropriate junction.

» Check the box next to the Control Valve Junction J2 in the "Assign
Design Requirements to Control Valves" section. The Design
Requirements panel should now appear as shown in Figure 2.8.

7 Wotspace | # Sng | P8 ModeiDua | EJOuput | I8 Gaph et | Vil Report |11
o LockPanel | @8 Lock All Panels 8 Untock All Panels 7] Show Status Panel

(2] Define Control Valve Design Requirements

| N&? || h“?i” ”m& " &e || m‘zn |M:ﬂub_|hﬂl-mtm=lh“llmulm

Value | Units
_ WOkPs |

Max/Min
| =

|+ Assign Design Requirements to Control Valves

c.uuml i)

2 [=]

EQ ¥i@ Showng: 1 of 1 Control Valves: (A) Mote: The Design Requirement assignments on this panel are in refere;

[>) Description and Helo

Figure 2.8 Minimum pressure drop requirement defined for the
Control Valve
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Note: It is strongly recommended that control valves have a Design
Requirement specified for the minimum pressure drop or the maximum
Cv/percent open at the valve. If no Design Requirements are applied, the
ANS module will allow the control valve to control to any pressure
required to meet the control setpoint, even if this requires the control
valve to add pressure to the system for design purposes. To avoid this
behavior in the final solution, a Design Requirement should be applied.

E. Assign cost databases

This panel is only used to assign the necessary monetary cost
information when Monetary Cost is chosen as part of the Sizing
Objective. In this case this button is greyed out since we are minimizing
pipe weight.

F. Sizing method
Select the Sizing Method button from the Sizing Navigation Panel.

The Sizing Method panel is used to set up the calculation methods to be
used for sizing the system. The user has the option to select whether
discrete or continuous sizing will be used, and which search method will
be applied.

If Continuous Sizing is selected, the ANS module will use the minimum
and maximum Candidate Set sizes as boundaries. It will then calculate
the ideal hydraulic diameter for the pipes being sized, which will likely
not match any of the available commercial sizes. While this is not useful
as a final solution, this may be helpful as a baseline to check the final
solution using the provided discrete methods. For this model, make sure
Discrete Sizing is selected.

For the Search Method, the ideal method will often change based on the
number of independent pipe sizes (number of pipes not in group &
Common Size Groups in sizing), number of Design Requirements, and
feasibility of the initial system design. The Help file provides more
information on the strengths and weaknesses of each method. It is
generally recommended to run the sizing with more than one method, as
it is often not obvious which method will be most effective for each
system. The “Suggest Best Method™ button is useful to determine a
search method to use initially.
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For a simple model such as this one, the Modified Method of Feasible
Directions (MMFD) or Sequential Quadratic Programming (SQP)
method should be appropriate since there is only one Design
Requirement, and only one pipe size is being varied. Choose the default
“Modified Method of Feasible Directions (MMFD)™.

Step 5. Run the automated sizing

We are now in a position to run the automated sizing. Before doing so,
take a moment to consider what this model is trying to accomplish. The
pipe P1 and P2 sizes will be selected together from the "STD Pipes"
candidate set such that their weight is minimized while still obtaining a
minimum 140 kPa pressure drop across the control valve.

To begin sizing the system select Run from the Analysis menu. While
the model is running, the Solution Progress window shows the "Sizing
Calls to Solver". This is how many times a complete compressible flow
analysis was run.

The Solution Progress window also displays the Current Cost, which is
the last calculated value for the cost, as well as the Best Feasible Cost
which has been found so far (Figure 2.9). The Solver will continue to
iterate using the defined method to find a global minimum. For most
methods, the Solver will first perform a continuous sizing, then perform
discrete sizing based on the continuous solution, though this is not
always the case.

Note: For complex systems using the Genetic Algorithm Sizing
Method, the solution can be paused and accepted at any time by using
the Pause button, then selecting “Accept Sizing” under Other Actions.
This allows the user to accept the best current solution, rather than
continuing to search for the global minimum.

When the sizing has completed, click the Output button to display the
results.
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Figure 2.9 The Solution Progress window shows the progress of
the AFT Arrow Solver and the ANS module

Step 6. Review automated sizing results

The Cost Report tab in the General Output section shows a total weight
of 902 kg, while each pipe has a weight of 451 kg (Figure 2.10). This
result makes sense since the pipes have the same length and a common
diameter due to the fact that they are in a Common Size Group.

The Sizing tab in the Pipe Output section shows the ideal pipe size was
found to be 3 inch for the pipes when sized together.

The CV Design Requirements tab shows that the 140 kPa minimum
pressure drop is satisfied in that the pressure drop for 3 inch pipe was
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Conclusions

236.8 kPa. Note that the Design Requirement result is highlighted in
blue, indicating that the Design Requirement was active during the
continuous solution, but the pipe sizes in the discrete solution were
outside of a certain limit from the continuous solution pipe sizes. Yellow
highlighting will be used if the Design Requirement is active in the final
solution, and the difference between discrete and continuous solution
pipe sizes is within the defined limit.

Output o x
R g 2 BnxE
£  General |Wamnings | CostReport |Valve Summary | Tank Summary

# Pipes Awial Points | Heat Transler | Sizing

[ Name | Sized- Sized - Sized - Type/ | Sized- Hyd.
Fipe Material | Nominal Size e o

Pipe  Steel- ANSI 3inch STD (schedule 40)
Fipe  Steel - ANSI 3inch STD (schedule 40)

& | All Junctions | CV Design Requirements | Control Valve | Tank

Fressure Drop Static Minimum
Jet > 140 kPa
Pressure

12

Base Scenario ([Quwe @ )+ @

Figure 2.10 The Output window shows the results of the sized
system, plus the sizing results. The blue color for the
CV Design Requirement indicates this Design
Requirement was “Active”.

This example demonstrates the automated sizing capabilities of the ANS
module for a simple system with a single Design Requirement. Sizing for
non-monetary objectives such as pipe weight is fast and easy to
implement.
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CHAPTER 3

Initial and Life Cycle Cost Sizing

This example demonstrates some key features by using the ANS module
to size an air distribution system for monetary cost.

Topics covered

e How to connect and use existing engineering and cost databases
e Sizing for Initial or Life Cycle Cost and using Initial Cost Limits

e The process to size a compressor, and size piping for the chosen
compressor

e Interpreting Cost Reports

Required knowledge

This example assumes that the user has some familiarity with AFT
Arrow and the ANS module such as placing junctions, connecting pipes,
entering pipe and junction specifications, and creating and using
Candidate Sets and Design Requirements. Refer to the Weight Sizing
Example in Chapter 2 for more information on these topics.

Model files

This example uses the following files, which are installed in the
Examples folder as part of the AFT Arrow installation:
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Metric - Air Distribution - ANS.aro - AFT Arrow model file

Metric - Air Distribution - ANS COMPLETE.aro — completed AFT
Arrow model file

Metric - Air Distribution Components.dat - junction engineering
database

Metric - Air Distribution Components Cost.cst - cost database
associated with Air Distribution Components.dat

Metric - Air Distribution Pipe Cost.cst - cost database for steel
piping

Problem statement

This example uses an existing model to investigate three automated
sizing cases:

1.
2.
S

Size system for initial cost with a 5-year system life
Size system for life cycle cost with a 5-year system life

Size system for life cycle cost with an initial cost limit for a 5-year
system life

Step 1. Start AFT Arrow

From the Start Menu, choose AFT Products and AFT Arrow.

Enable the ANS module from the Startup Menu by checking the box next
to the ANS module. Alternatively, the ANS module can be activated
from the Module button at the bottom of the Quick Access Panel, or from
the Activate Modules option in the Tools menu.

Step 2. Open model file

For this example we will be starting from a pre-built model file that is
fully defined for a normal AFT Arrow run. We will use automated sizing
to find a more cost-effective design. From either the startup screen or the
File menu, browse to the model file name shown above and copy it to a
new location. The Workspace should appear as shown in Figure 3.1.
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Figure 3.1 Air Distribution example model

Sizing systems with compressors

A centrifugal compressor can be modeled with a Compressor Curve or
with a fixed flow rate or pressure as the Sizing option. Generally, if a
specific compressor has been identified, the Compressor Curve type
would be chosen, whereas the Sizing option is useful during the selection
stage in order to identify the compressor requirements for the system. In
some cases, even though the specific compressor has not been chosen,
several candidate compressors are available. For this third case it would
be best to model each candidate compressor with a compressor curve
using separate scenarios for each compressor.

Compressor model in this system

The compressor in our air distribution case is set as Sizing with a fixed
flow of 2125 sm3/h. In order to allow the compressor to be defined as a
fixed flow, the flow control valve at J131 has been defined at a fixed
pressure drop of 14 kPa. This model thus represents a first cut model
where, based on the first cut results, the compressor will become an
actual compressor with a compressor curve, and control valve J131 will
become a flow control valve controlling to 425 sm3/h, similar to the
other control valves.
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As already stated, when a compressor is modeled as a fixed flow, it is not
a specific compressor from a specific manufacturer. Thus, the costs for
the compressor can only be approximated. For a first approximation it
should be possible to estimate the non-recurring cost (i.e., material and
installation cost) for the compressor as a function of power requirements.
For instance, a typical ten kilowatt compressor (of specific configuration
and materials of construction for a given flowrate) may cost $2700, and a
forty kilowatt may cost $8250. Other typical costs for different power
requirements can be approximated. The actual cost for the compressor
will highly depend on the application. These costs are entered into a cost
database and are accessed by the Solver. As AFT Arrow evaluates
different combinations of pipe sizes, each combination will require a
certain power from the compressor. With a cost assigned to this power,
the ANS module can account for energy costs over the life of the system.
Later in this chapter, we will look at the costs for the compressor in our
example air distribution network.

In addition to non-recurring costs, recurring costs can also be estimated.
Specifically, the cost of the power used by the compressor over a period
of time (which the ANS module calls the "system life") can be
determined. All AFT Arrow needs is an overall compressor efficiency to
determine the actual power from the ideal power. Again, since we do not
have a specific compressor selected yet, the efficiency can only be
approximated. The ANS module calls this the "nominal efficiency".

A step-by-step method of compressor selection proceeds in two phases.
The steps are outlined in the Help System.

Step 3. Review model settings

The model is already defined, but we need to review and complete the

sizing settings before running the analysis. In the Analysis menu check
that Automated Sizing is set to Network, then go to the Sizing window
by clicking the tab.

A. Sizing objective
The Sizing Objective panel should be displayed by default.

To begin we will first need to choose the calculation option, so select
“Perform Sizing”.
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The Sizing Objective panel also provides features to characterize the
automated sizing objective. As explained previously, a non-monetary
parameter such as weight could be chosen to simplify the sizing.
However, there are a few downsides to this method, as this does not
allow one to include compressor costs, or other junction initial costs, in
the sizing. Additionally, recurring costs cannot be calculated using non-
monetary cost. To more thoroughly size the compressor in this system
we will need to minimize monetary cost directly.

Select Monetary Cost as the Objective and select Minimize.

With the Monetary Cost selected, the options to minimize monetary cost
will appear displayed in a table, along with several options to the side
that will activate depending on the cost types being analyzed. Several
common analysis types can be selected in the list box above the table to
automatically configure the table.

From the list box choose “Size for Initial Cost, Show Energy Costs”.
This will set the table to include material and installation costs in the
Sizing Objective and will calculate the energy costs without including
them in the Objective, as can be seen in Figure 3.2. This will allow us to
size for the initial costs and include the energy costs for comparison
when we later size the system for life cycle cost (initial costs and
recurring costs combined).

Since the energy costs are included in the cost calculation, the user must
provide a System Life and, optionally, interest and inflation rates to
calculate the present value of the recurring costs.

Enter 5 years for the System Life, with 0% for the interest and inflation
rates.

The source of the energy costs must also be defined. Simple energy costs
can be entered here, or it can be specified that energy costs come from
energy cost databases, which would need to be added on the Assign Cost
Databases panel. An Energy Cost Database allows variable energy costs
to be used to account for varying prices during different times of day,
different seasons, etc. If using the more straightforward simple energy
costs, and if the compressor does not run all day every day, the easiest
approach is to reduce the Energy Cost by an appropriate ratio.

Choose "Use this Energy Cost Information”, with a cost of 0.11 U.S.
Dollars per kW-hr. Note this assumes the compressor will run all day,
every day, for the entire 5 years.

The Sizing Objective panel should now appear as shown in Figure 3.2.
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Figure 3.2 Sizing Objective panel setup for an Initial Cost
analysis

B. Size/Cost assignments

On the Sizing Navigation Panel select the Size/Cost Assignments button.
For this example we are sizing both the pipes and compressor for a new
system, so we will need to calculate and minimize cost for all related
components in the model.

» Select the Pipes button and set all pipes to “Always Include in Cost™.
See Figure 3.3.
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Figure 3.3 Size/Cost Assignments panel with all pipes included
in sizing

To decrease the run time, reduce complexity and enforce some design
uniformity, it is useful to create Common Size Groups to link the pipes
in different sections of the model.

Note: The Number of Independent Pipe Sizes in the model can be
seen in the bottom right of the Size/Cost Assignments panel, and
denotes the number of pipe sizes being independently varied (i.e. the
number of Common Size Groups, plus the sized pipes not in a group).
This information is useful for choosing Sizing Methods.

For example, if all the 18 pipes are selected to be “Not In Group”, then
18 pipe sizes will be independently selected by the automatic sizing
engine. That could potentially mean, for example, different pipe
diameters in pipes P111 and P112. If one wanted these pipes to be sized
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to the same diameter, one would group them into a Common Size Group.
To see how this works, in this model all discharge room piping will be
put into a Common Size Group. This means that there will be one
diameter chosen for this group of pipes, rather than potentially ten
different diameters.

For this system we will define 4 groups. To set the groups, it is common
to select pipes which must have the same size due to their placement
relative to other pipes and junctions, such as pipes at the entrance and
exit of valves. In Figure 3.4 we have identified these four groups.

First let’s create a “Compressor Piping” size group for pipes P1 and P2.

Click the “New” button above the Pipe Grouping section to create the
group, and name it “Compressor Piping”. Select the radio buttons under
the “Compressor Piping” heading next to P1 and P2 to add them to the
group. Alternatively, the pipes can be selected in the Workspace, then
moved to a group by right-clicking the Workspace and selecting the
corresponding option from the menu.

Now let’s repeat this process for the discharge piping leading to each
room. We will assume five identical control valves will be purchased, so
therefore all these pipes will have a common size. Like before, create a
new group called “Discharge Piping”, and add the pipes outlined in
Figure 3.4 to the new group.
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The headers supplying each room are one physical pipe in the field,
represented as multiple pipes in AFT Arrow by necessity. Create two
more groups; “Room A Header” and “Room B Header” and add the
appropriate pipes to them. The Size/Cost Assignments should now
appear as shown in Figure 3.5.

Note: Pipes in the Size/Cost Assignments table can be sorted by
Common Size Group instead of sorting by number by clicking on the
"Pipe Grouping" header. Clicking on the header for a particular group
will sort the pipes in that specific group to the top of the window.

» Click the Comp./Fans button to switch to the Compressor Size/Cost
Assignments. Select the option to “Include in Cost Report and Sizing™
for the compressor so that the ANS module will size the compressor
along with the pipes as shown in Figure 3.6.
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Figure 3.5  Pipe settings in the Size/Cost Assignments panel
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Similar to the Common Size Groups for pipes, Compressors can be
placed into Maximum Cost Groups based on monetary cost. If
compressor costs are added to a Maximum Cost Group, the ANS module
will determine the compressor in the group with the maximum costs and
set all compressors in the group to the same costs as that compressor. In
this case there is only one compressor so we cannot create a group.

Now go to the Workspace window. It is possible to inspect the Common
Size Groups in the model by coloring the pipes. From the View menu,
select All under Color Size Groups. The model should appear as shown
in Figure 3.4, though the colors may be different.

*Workspsce | & Sizing | [ ModeiData | [JOutput | 12 GraphResults | ® Visual Report
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@ Ppes || Comp /Fans _#8 Control Vaives | -2 General dunctions |
Size/Cost Assignments

Move to:

A | None || invet || Workspace || Special... | Number of Independent Pipe Sizes: 5

Figure 3.6  Compressor settings in the Size/Cost Assignments
panel

C. Candidate sets
Click on the Candidate Sets button to open the Candidate Sets panel.

You should see that the STD Steel 2”-10” Candidate Set has already
been created for the model. Expand the set by clicking the “+” sign next
to its name to see that selected pipe sizes from 2" to 10" have been added
for STD Steel - ANSI pipe.



Chapter 3 Initial and Life Cycle Cost Sizing 37

In the bottom section of the window, check that each of the Common
Size Groups and pipe P3 have been assigned to use the existing
Candidate Set. The window should appear as shown in Figure 3.7.

D. Design requirements
Select the Design Requirements button.

Design Requirements can be applied to both sized and unsized pipes and
junctions. Design Requirements are design limitations on certain
parameters. For example, there may be a Design Requirement that the
velocity cannot exceed 25 m/sec. As the ANS module evaluates different
pipe sizes, if a particular size results in a velocity greater than 25 m/sec,
that pipe size is rejected because it causes a Design Requirement
violation.
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Figure 3.7  Candidate Sets panel fully defined for the model
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When a pipe that is not sized has a Design Requirement, it means that the
sized pipe sizes cannot be such that it violates the Design Requirement
for the unsized pipe. There can be multiple Design Requirements defined
and applied to a pipe, junction or group. For instance, in addition to a
maximum velocity limit, a maximum pressure limit may exist. Individual
pipes/junctions in a Common Size Group can have different Design
Requirements applied.

For this model we have multiple requirements for the system:

1. All pipes have a maximum velocity of 45 m/sec

2. All control valves must have a minimum pressure drop of 14 kPa
3. All discharges must receive a minimum flow of 425 sm3/h

Define and assign the first requirement listed above as a Pipe Design
Requirement for overall velocity and assign it to all of the pipes as
shown in Figure 3.8.

For flow control valves J111, J121, J211, and J221, define and apply the
minimum pressure drop requirement in the Control Valves section as
shown in Figure 3.9. Note that for compressor sizing purposes as
discussed earlier control valve J131 has been defined as a Constant
Pressure Drop valve, so the pressure drop Design Requirement does not
need to be applied to this valve.

Notice that we have accounted for the minimum flow requirement in this
system by using flow control valves in each discharge line. By using an
assigned flow compressor and flow control valves at each discharge, we
have incorporated the necessary flow rate as a boundary condition, so we
do not need to apply a Design Requirement to account for this item.

E. Assign cost databases

Select the Assign Cost Databases button. The material and installation
costs for all pipes and junctions being sized must be entered into cost
databases, which are then assigned to the appropriate components here,
The cost databases needed for this example have been pre-built, and just
need to be accessed.
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Figure 3.8 Design Requirements panel for pipes
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Figure 3.9 Design Requirements panel for control valves
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The Database Manager (opened from the Database Manager button or
Database menu) shows all of the available and connected databases.
Databases can either be engineering databases or cost databases. Cost
databases are always associated with an engineering database and are
thus displayed subordinate to an engineering database in the database
lists. Here we will summarize some key aspects of databases:

e Cost information for a pipe system component is accessed from a
cost database. Cost database items are based on corresponding items
in an engineering database. (The engineering databases also include
engineering information such as pipe diameters, hydraulic loss
factors, etc.)

e To access a cost for a particular pipe or junction in a model, that pipe
or junction must be based on items in an engineering database.
Moreover, that database must be connected to the model, and to the
specific item in the model.

e There can be multiple cost databases associated with and connected
to an engineering database. This makes it easier to manage costs of
items. If multiple cost databases are assigned to a Candidate Set, then
the costs will be stacked to find a cumulative cost.

» Open the Database Manager by clicking the Database Manager button.
The AFT DEFAULT INTERNAL DATABASE, AFT ARROW LOCAL
USER DATABASE, and PIPE MATERIAL DATABASES should be
available and connected by default. In the top section of the window,
Available Databases will be shown based on databases that AFT Arrow
has identified on your machine. The default connected databases will be
visible here, and additional databases may be visible from other example
files, or from databases previously built and used on your machine.

This example uses one user-defined engineering database, “Air
Distribution Components.dat”, which contains the data for the
compressor. There are also two cost databases, “Air Distribution
Components Cost.cst” and “Air Distribution Pipe Cost.cst”, which
contain the cost data for the junctions and the pipe materials,
respectively. “Air Distribution Components Cost.cst™ was built off of the
engineering database “Air Distribution Components.dat”, and “Air
Distribution Pipe Cost.cst” was built off of the default PIPE MATERIAL
DATABASE. To connect these databases, do the following:

1. Click the button to "Edit Available List" and select “Add
Engineering Database™.
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2. Browse to the AFT Arrow 8 Examples folder (located by default
in CA\AFT Products\AFT Arrow 8\Examples\), and open the file
titled "Metric - Air Distribution Components.dat".

3. Repeat the above steps, but choose “Add Cost Database™ to
browse for “Metric - Air Distribution Components Cost.cst”,
then “Metric - Air Distribution Pipe Cost.cst”.

Once these steps have been completed, you should now see that the new
databases have been added to the Available Databases list, and have been
automatically connected to the model so that they can also be seen in the
Connected Databases list, as shown in Figure 3.10 for the component
databases. The component databases appear in the Connected Databases
section under the names “Air Distribution Components™ and “Air
Distribution Components Cost”, with the cost database indented beneath
the engineering database to denote that they are linked. The cost database
for the pipes appears with the name "Air Distribution Pipe Costs” and is
similarly indented under the Steel-ANSI database within the standard
pipe material databases.

Once you have confirmed that the necessary databases are connected as
shown, click Close to exit the Database Manager.

Database Manager

Connect to Database | Cost Database Info | Edit Database
Avaiable Databases: Filename: C \AFT Amow 8'\Examples'Metric - Ar Distibution Components Cost cst
AFT DEFAULT INTERNAL DATABASE S Edi Avalsble Lt ~
AFT ARROW LOCAL USER DATABASE
=} Companent Database for Ar Distribution Components
£ A Distebution Equipmert Costs
-6 PIPE MATERIAL DATABASES

Disconnect Database I Review Contert

Connected Databases §l B, ] Database Sections (Select Desred Sections)
AFT DEFAULT INTERNAL DATABASE HE
AFT ARROW LOCAL USER DATABASE
= Comgonent Database for Air Distribution Components

4 ) PIPE MATERIAL DATABASES

User Defaut
Set Pipe Matenals Set as Default

[ Same fsParert  ~ @ Close ¥ Hep

Figure 3.10 Database Manager showing the Air Distribution
databases connected and available
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Since we are connecting a pre-built database, we will need to take an
additional step to make sure that the compressor in the Workspace is
linked to the Air Distribution engineering database that we added.

1. Go to the Workspace, and open the compressor (junction J2)

2. From the Database List, select “Fixed Flow 2125 sm3/h”. None of
the input should change, as this database item is identical to the
existing compressor. However, AFT Arrow will now recognize that
this junction is connected to the engineering and cost database for
this compressor.

We have now re-connected the junctions that will be considered for the
Cost Report and sizing calculations to the engineering database. This is
important, since a junction must be connected to an engineering database
before cost information can be assigned to it. Let's now return to the
Sizing window.

Back in the Assign Cost Databases panel for the Pipes, the “Air
Distribution Pipe Cost” database should now be visible in the table.
Make sure that the database is checked to be applied for the model as
shown in Figure 3.11.

» Click on the Comp./Fans button, to view the cost database assignments
for the Compressor. The “Air Distribution Components Cost™ database
should now be available. Make sure that the checkbox is selected under
the database name so that the cost data will be applied for the compressor
(Figure 3.12).
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Figure 3.11  Assign Cost Databases panel for pipes
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Figure 3.12 Assign Cost Databases panel for compressors

F. Sizing method
Select the Sizing Method button to go to the corresponding panel.

Select Discrete Sizing to complete the sizing for a set of commercial
pipe sizes.

For this model we have 5 independent pipe sizes as noted on the
Size/Cost Assignments panel (4 groups and pipe P3), and 2 design
requirements (1 pipe design requirement applied to all of the pipes, and a
minimum pressure drop applied to 4 control valves). Due to the small
number of independent sizes, it would be recommended to try the
MMEFD or SQP search method. Though it is not shown here, if both
methods are run for this scenario the same solution will be obtained,
though the Sequential Quadratic Programming (SQP) Method is slightly
faster. Select this method from the list as shown in Figure 3.13.

Note: Different Search Methods will not always produce the same
result, so it is always recommended to run the automated sizing with
multiple search methods. The MMFD and SQP methods are
recommended when there are less than 10 independent pipe sizes,
while the GA and SU methods will work better for models with more
than 10 independent pipe sizes. These are discussed further in the
Help file.
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Figure 3.13  Sizing Method panel defined for Discrete sizing with
the Sequential Quadratic Programming method

G. Sizing summary
From the Sizing Navigation Panel select the Sizing Summary button.

The Sizing Summary panel allows the user to view all of the sizing input
for the model in a tree view layout, which is shown in Figure 3.14. Items
can be organized by sizing parameters (Design Requirements, Candidate
Sets, etc.), or information can be viewed for an individual pipe. For
clarity these categories can be shown/hidden using the check boxes at the
top of the panel.

Each tree node can be expanded/collapsed individually by using the “+’
and *-* buttons on the node. Alternatively, the buttons on the bottom of
the panel can be used to collapse/expand all items. Right-clicking on the
nodes provides additional options to collapse/expand items, view related
nodes, or to copy information to the clipboard. The Sizing Summary
panel can be printed from the printer button at the bottom of the panel.
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Figure 3.14  Sizing Summary panel layout with the Size/Cost
Assignments expanded. The number of children
nodes for each item can be seen in parentheses.

Step 4. Run the model

Select Run Model in the Analysis menu. This will open the Solution
Progress window. This window allows you to watch as the AFT Arrow
Solver and the ANS module converge on a solution.

After the run has been completed, the results can be reviewed by clicking
the Output button at the bottom of the solution control window.
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Step 5. Review the output

Itemized
Pipe
Costs

Itemized
Comp.
Costs

The Cost Report is shown in the General Section of the Output window
(see Figure 3.15). The ANS module shows all costs in the Cost Report,

including those that were calculated but not used in the automated sizing.
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Figure 3.15 The Cost Report in the Output window shows the
total and individual costs for the sized system

The total cost for this system is $198,056. This includes all costs over 5
years. The initial cost, which was the basis for the automated sizing, was
the total of the material and installation costs ($69,555). This total is
listed as the total for the "Items in Sizing" line, since it was specified to
only include the initial costs (material and installation) in the Sizing
Objective section. Individual items that were included in the automated
sizing have their costs highlighted in green.

Other costs that are displayed in the Cost Report are "Items Not in
Sizing". These are items that were set to have their costs calculated but

Total
Cost
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were not included in the automated sizing. Note that the Items Not in
Sizing total to $128,501. Looking across at the subtotal one can see that
all of this cost is in energy (i.e., compressor power costs). The total cost
is the sum of the two. This cost will be included in the automated sizing
later for comparison.

In the Pipes section of the Output window the final pipe sizes from the
automated sizing can be seen, along with the Design Requirements
status. For this sizing there were multiple pipe velocity requirements that
were active, as is indicated by the highlighting (Figure 3.16). Though not
shown here, one of the control valves also had an active design
requirement in the model.

For this model, the final system used pipe sizes varying from 2-1/2 to 6
inches, as seen in Figure 3.17. Data on the Common Size Groups and
pipe costs can also be viewed from here. The information for the
compressor can be seen in the Compressor/Fan Summary tab in the
General Section, which is also shown in Figure 3.17.

When a monetary cost objective is selected, additional tabs are available
that display the Database Sources used for the Cost Report for each of
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Figure 3.16  Pipe Design Requirements section with the active
design requirements highlighted

the pipes/junctions. In this case both the Pipe Material and Pipe
Installation costs for all of the pipes came from the “Air Distribution
Pipe Cost” database which was connected earlier. Information for the
Compressor came for the “Air Distribution Components Cost” database.
If multiple cost databases are used for the same cost type they will all be
listed separated by commas. This is useful for model verification.

On the General tab of the Output window at the bottom of the report, the
initial cost of the items included in the sizing can be seen, which was
$110,156 for this design, showing the initial costs were reduced by about
37% from the initial design. We can also see that the initial design was
feasible, meaning all of the design requirements were met (Figure 3.18).
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Figure 3.17 Compressor and pipe sizes after initial cost sizing is
performed

Though not shown here, if the model is run using the objective to
“Calculate Costs, Do Not Size”, it can be seen that the total cost for the
system before sizing was $178,719, which is actually less than the
system that has been sized for initial costs. This is due to the fact that the
larger pipe sizes in the original design allowed for lower energy costs
over the 5 year system life, even though the material and installation
costs were larger. This indicates that this system is weighted towards
energy costs, since they have a large impact on the overall cost.
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Figure 3.18  General section of Output window showing initial
status of Iltems in Sizing

Step 6. Size system for life cycle cost

‘;f

Now we want to size the system based on life cycle costs, rather than just
minimizing the initial costs of the system. As previously discussed, the
energy costs can often be weighted much more heavily than the initial
cost of the system components. This means that sizing based on recurring
costs will often result in larger pipes with higher material/installation
costs being chosen so that smaller compressors with lower energy costs
can be used.

From the Scenario Manager in the Quick Access Panel, we will create
two child scenarios. With the “Metric Units” scenario selected, right
click and choose “Create Child”. Name the new scenario “Initial Cost”.
This scenario will store the initial cost sizing results we just obtained.
Repeat this process to create a second child scenario under “Metric
Units”, and name it "Life Cycle Cost". The “Life Cycle Cost” scenario
should now be active, as indicated by the green check mark symbol. For
this scenario the only change that will need to be made is to update the
Sizing Objective.

Go to the Sizing window, and make sure that the Sizing Objective panel
is selected. Under “Options to Minimize Monetary Cost”, choose “Size
for Initial and Recurring Costs”. This will move the Energy costs
selection to “Include in Sizing Objective” as shown in Figure 3.19. The
scenario is now complete.
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» Click Run from the Analysis menu to run the automated sizing. When
the calculations have finished, click Output to view the results. The new
Cost Report can be seen in Figure 3.20.

After viewing the Cost Report, it can be seen that the overall cost is now
$166,343. The "Items Not in Sizing" line now has a value of zero, and
the Energy column is highlighted green, reflecting the changes made to
include these costs in the Objective.

Options to Minimize Monetary Cost
Size for Initial Cost System Life (For Recuming Costs)
Size for Initial Cost. Show Energy Costs s Ufe: E pen =

v

CostType | Sezing Repor e

Objective | Only Energy Cost
Initial Costs (O Use Energy Cost Databases
(® Use This Energy Cost Information
Material :
= o Cost: U.S. Dollars -
Installation ® ) O Per: |kWhr v
- this fixed energy cost set here will be used. Al
Recuming Costs %WWhH\eD&MWdh
ignored.

Energy ® O O

[ Iinitial Cost Limit

Maintenance . O ® US.Dolas

EA Wam When Fittings & Losses Costs are Missing

ost Candidate Design Assign z
erts Sets Requirements Cost Databases Method

Figure 3.19  Options to Minimize Monetary Cost section of Sizing
Objective panel defined for life cycle cost sizing
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Output
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Figure 3.20 Cost Report for life cycle cost sizing scenario

Taken on its own, this new cost represents a savings of about $32,000
over the Initial cost scenario which was sized based on Initial Cost only.
This represents a 14% cost reduction, In the initial cost scenario, the non-
recurring cost was $69,555, while the overall cost was $198,056. Now
the non-recurring cost is $92,464 while the overall cost is $166,343. The
initial cost thus increased by about $23,000 in order to reduce the
operating cost from $128,501 to $73,879 (a reduction of about $55,000).
The source of the operating cost is the cost of power for the compressors.
To reduce compressor power usage, it makes sense to increase the pipe
size and thus reduce frictional losses. The larger pipe sizes can be
reviewed by looking at the Sizing tab in the Pipe Output section.
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Step 7. Apply initial cost limit

v

While the energy cost savings from life cycle cost sizing are desirable,
the budget for the project may not support the higher initial cost that is
required. In that case, we can apply an initial cost limit to the life cycle
cost sizing.

Return to the Sizing Objective panel and select the option for Initial
Cost Limit. We will set the limit as $85,000, which is the given budget

for this project. Run the model and go to the Output tab. The Cost Report
can be seen in Figure 3.21.

Note: The initial cost in the final solution may be lower than the
actual Initial Cost Limit that was defined, as is the case with this
scenario. This occurs due to the Common Size Groups reducing the
number of possible pipe size combinations. If the pipes in the Room A
Header group are removed from the group, then the initial cost for the
final solution is much closer to the $82,500 initial cost limit,

A summary of the difference between each of the initial and life cycle
cost sizing scenarios for a 5 year life cycle can be seen in Table 3.1.
Notice that while the material and installation costs were similar to the
costs from the initial cost scenario, the energy costs were decreased by
about $10,000. These energy costs were achieved by increasing the
compressor pipe sizes, while decreasing the header pipe sizes to achieve
a better efficiency in the compressor. Table 3.2 shows a comparison of
the pipe sizes throughout the system for the original design and each of
the sizing scenarios.

Table 3.1 Cost Summary of automated sizing runs for the Air
Distribution System

Sized for: Material |Installation| Total Non-| Energy | Overall Total | Reduction

recurring

Not sized

67,223 42,933 110,156 68,563 178,719

Sized for Initial cost

42,256

27,298

68,555

128,501

198,056

-20,000

Sized for Life cycle cost

57,248

35,216

92,464

73,879

166,343

12,400

Sized for Life cycle cost with
initial cost limit

44,930

27,850

72,780

118,284

191,064

-12,300
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Table 3.2 Summary of final pipe sizes from automated sizing
runs for Common Size Groups in Air Distribution
System
Sized for: Compressor | Room A | Room B Discharge Pipe P3
Pipes Headers | Headers Piping
Not sized 6" 6" 6" 3 6"
Sized for Initial cost 6" 47 4" 2-1/2» 4
Sized for Life cycle cost 8" 5" Siid 4 9
Sized for Life cycle cost with 8" 4” 4 3-1/2 4”
initial cost limit
Dutput a x
B LBy E
_ﬁ _G«mﬂ_w_c«lw Cuwwﬁm&mmy_\fdnw_T-*m_
e Type Name Material | Installation | oG Recurning | Mainterance °g,:*,,_;" | Sepuring | TOTAL
TOTAL OF ALL MODEL COSTS 191
Total of All Shown Costs 44,930 27,850 72,780 0 118284 118284 191,064
Items In Sizing 27,850 72,780 0 118284 118284 191.064
ltems NotIn Sizing 0 0 0 0 0
Pipe Subitotal 25,453 65,590 ] 0 0 65,590
(o P Five ) 293 ol 0 0 2sm
lo|r2 Pipe s 2481 7482 o [T 0 742
lolra Pipe 806 598 15,011 o 0 1o
Lo [P101 Pipe o453 2m 7505 o T 0 7505
[o|P102 Pipe s 2 7505 o o 0 7505
Lo |P102 Pipe 4513 29% 7505 o G 0 7508
Lo [P111 Pipe Com 28 o IS o 2%
Lo |Pii2 Pipe B I 28 o 0 2
[ |p121 Pipe | e 28 o D 0 2%
Lo P12z Pipe B B ) 28 o G o 2%
Lo [P131 Pipe o e 28 o NG 0 28
Lo M2 Pipe B BT 28 o 0 0 2
|0 [P Pipe a5 2w 7505 o NG 0 7505
| o [P202 Pipe a5 2w 7508 o G 0 7505
I Pipe o e 258 o NG o 2
Lo P12 Pipe Com e 28 o G 0o 28
Lo |P221 Pipe o 8 o G o 2%
o|r2z2 pie T BN o
7.1%0 0 118284 118284 125474
7,150 0 118,284 125474

Figure 3.21

Cost Report for life cycle cost automated sizing
scenario with initial cost limit
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Conclusions

Discussion on sizing with compressor curve data

One can consider the previous discussion in this chapter as Phase | of the
compressor and pipe sizing process. Phase 2 involves using the Phase 1
results in order to select actual compressors which have compressor
curve data. The actual compressor should closely match the sizing results
in the generated pressure at the design flow, efficiency at the design
flow, and cost. If it does not, then it may be advisable to repeat the Phase
1 sizing with updated information from actual compressors (e.g.,
monetary costs, nominal efficiency, etc.). A complete Phase 2 analysis
will run the automated sizing again for each actual compressor
considered. The pipe sizing may change slightly for each compressor
considered.

By reviewing the Compressor/Fan Summary for the life cycle cost sizing
with an initial cost limit, one can see that the ideal system calls for a
compressor of about 26 kW that generates about 38.6 kPa of pressure at
2125 sm3/h. The nominal efficiency used in the sizing part of the
analysis was 80%. The material cost for such a compressor was about
$5,800, and the installation cost was about $2,400. Note that if no actual
compressors can be found that reflect these requirements, then the Phase
1 process should be repeated with better performance and/or cost data for
the compressor.

Using cost databases in the automated sizing process involves increased
complexity from simple non-monetary automated sizing as discussed in
Chapter 2. However, it allows more powerful automated sizing options

including the ability to size costs over a system life cycle.
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CHAPTER 4

Multiple Design Case Example

This example will size the pipes for a natural gas supply system to five
burners. It is desired to analyze two separate design cases using monetary
cost automated sizing.

Topics covered

This example will cover the following topics:

e How dependent design cases are used to satisfy two different
operating modes for a system

e Common Size Groups and their effect on how well the ANS module
can size a system

Required knowledge
This example assumes that the user has some familiarity with AFT
Arrow and the ANS module such as placing junctions, connecting pipes,
entering pipe and junction specifications, and creating and using

Candidate Sets and Design Requirements. Refer to the Weight Sizing
Example in Chapter 2 for more information on these topics.

Model files

Metric - Natural Gas Burner.aro - AFT Arrow model file
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STD Steel Pipe Costs.cst - Pipe cost database for steel pipe

Problem statement

This example uses an existing model to investigate a single system with
two operating cases. The cases are as follows:

1. Normal flow to burners requires 2.4 kg/sec controlled by flow
control valves. The pressure drop across the flow control valves
must be at least 1.7 bar and velocity at the burners must be less than
60 m/sec.

2. The one burner off case has the center burner turned off. Total flow
must be maintained, so each flow control valve must supply 3
kg/sec at a pressure drop of 1.7 bar, with the 60 m/sec maximum
velocity requirement still applied.

We will design for both operating cases by first configuring the sizing
settings for the normal flow case, then creating the one burner off case
using the Dependent Design Cases feature.

Step 1. Start AFT Arrow

From the Start Menu, choose AFT Products and AFT Arrow,

Enable the ANS module from the Startup Menu by checking the box next
to the ANS module. Alternatively, the ANS module can be activated
from the Module button at the bottom of the Quick Access Panel, or from
the Activate Modules option in the Tools menu.

Step 2. Open model file

For this example we will be starting from a pre-built model file that is
fully defined for a normal AFT Arrow run, We will add automated sizing
settings to find a more cost-effective design. From either the Startup
Window or the File menu, browse to Metric - Natural Gas Burner -
ANS.aro and copy it to a new location. Open the model to the base
scenario.

This example consists of a natural gas supply (Tank J1) at 14 bar and 10
deg. C that supplies gas to five burners. All of the pipes in the system are
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STD Steel-ANSI. The supply line to the heat exchanger is fixed at 6-
inches. The model should appear as shown in Figure 4.1.
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Figure 4.1 Natural Gas Burner model layout in Workspace

Step 3. Review model settings

A. Sizing objective

Go to the Sizing window by selecting the tab. The Sizing Objective panel
should be selected by default from the buttons along the bottom.

For this analysis, we are interested in sizing the system considering the
monetary cost for the initial costs only.

1.
2.

Set the calculation to Perform Sizing.

For the Objective, choose "Monetary Cost", and select the Minimize
option from the drop-down list.

Under Options to Minimize Monetary Cost, choose "Size for Initial
Cost", which will automatically configure the table to include all
non-recurring costs in the sizing while ignoring the recurring costs.
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B. Size/Cost assignments

On the Sizing Navigation Panel select the Size/Cost Assignments button.
For the supply lines P1 and P2, the pipe size is fixed to 6 inches and will
not be sized. However, we still want to consider their cost. The rest of
the pipe sizes can be varied.

» Move pipes P1 & P2 to “Do Not Size — Include in Cost”, then select the
remaining pipes (P11-P72) and move them to “Always Include in Cost™.

The four header pipes (P3, P4, P5, P6) represent a single header in the
physical system, so it will be necessary to add them to a Common Size
Group. A second Common Size Group should be created to contain all of
the discharge piping (P7-P16), as each of the branches to the burners
should be identical.

» Select “New” above the Pipe Grouping table to create two new groups
with the names “Headers™ and “Distribution Piping”. Add pipes P3-P6 to
the “Headers” group, then add pipes P7-P16 to the “Distribution Piping”
group either from the table, or from the Workspace. The Size/Cost
Assignments table should now appear as shown in Figure 4.2.

' Workpsce | & Sizing | [ ModelDeta | EIOuput | B Graph Remults | 8 Visual Report
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Figure 4.2 Size/Cost Assignments panel for the normal flow
case
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C. Candidate sets
Click on the Candidate Sets button to display the Candidate Sets panel.

In this case we will be considering schedule 40 Steel pipe within the
range of 1" - 12",

1. Select New, and name the Candidate set "Steel Sch 40",
2. Choose Steel-ANSI from the material list.

3. Expand the “STD” type, then double click each of the sizes from 1
inch to 12 inch to add them to the Candidate Set.

4. Click OK to accept the defined set.

In the bottom section of the window make sure that the Common Size
Groups are assigned to use the Candidate Set as shown in Figure 4.3.

7 Workspace | & Sizing réllnddbuh | Eoutput | B2 Graph Results | ® Visual Report |
& Lock Panel (@ Lock All Panels & Unlock All Panels | 1] Show Status Panel

[~] Define Candidate Sets |

[ [ i [ J[ B (B ] mercmamecsre

Set Name

Sizes in Set: | 1inch, STD (schedule 40)
1-1/4inch, STD (schedule 40)

=8

[~] Assign Candidate Sets to Pipes

7
Assign To

Figure 4.3 Candidate Sets panel for the normal flow case
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D. Design requirements
Select the Design Requirements button.
In the normal flow case the following requirements need to be met:

1. The flow to the burners must remain below the maximum velocity
requirement of 60 m/sec.
2. All control valves must have a minimum pressure drop of 1.7 bar

Make sure that the Pipes button is selected, then create a new Design
Requirement named *Max Burner Velocity” specifying the maximum
velocity at the outlet of the pipe as 60 m/sec (Figure 4.4). In the bottom
section of the window, make sure that the velocity design requirement is
applied to each of the discharge lines to the burners.

—
" Workspxce | Sizing | [PModel Dsta | TI0utput | 12 Graph Resuls | ® VisualReport |
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|~ Assign Design Requirements to Pipes

Max Burmes
Common Size Groups “w_‘.“

= O
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P2
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P11 O
P12 M
P13 O
P14 %)
P15 O
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1 Notin Grouwp 0
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Figure 4.4 Pipe Design Requirements defined for the normal
flow case
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Next select the Control Valves button at the top of the window and create
a new control valve Design Requirement. Name the Design Requirement
“Min Pressure Drop”, and specify the Pressure drop static as a minimum
of 1.7 bar. In the bottom section apply the Design Requirement to each
of the control valves in the model (Figure 4.5).

7' Workspace | 7 Siing  [AModel Dats | [T Output | B2 Graph Results | % Visual Report |
o LockPanel @8 Lock Al Panels &8 Unlock All Panels I Show Status Panel

3 Poes |[ M Cortrol Vaives 2 General dunctions |

|El Define Control Valve Design Requirements

Figure 4.5 Control Valve Design Requirement defined for the
primary case

E. Assign cost databases

Select the Assign Cost Databases button. The actual material and
installation costs are contained in a pre-built cost database which we will
need to connect,

Open the Database Manager by clicking the Database Manager button
to see which databases are connected.

This example uses a pre-built cost database for the pipes containing the
Steel material costs. To connect the database do the following:

1. Click the button to "Edit Available List" and select Add Cost
Database.
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2. Browse to the Arrow 8 Examples folder (located by default in
C:\AFT Products\AFT Arrow 8\Examples\), and open the file titled
"STD Steel Pipe Costs.cst".

The new database should now be visible in the Available Databases list
and be automatically connected to the model, as shown in Figure 4.6.
Once you have confirmed that the database is connected, click Close to
exit the Database Manager.

Back in the Assign Cost Databases panel for the Pipes the "STD Steel
Pipe Costs" database should now be visible, and should be selected to
show that it is being applied to the Candidate Set and each of the supply

pipes.

Database Manager
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Figure 4.6 Database Manager showing the STD Steel cost
database connected and available in the model

F. Sizing method
Select the Sizing Method button to go to the Sizing Method panel.

Ensure that Discrete Sizing is selected with the Modified Method of
Feasible Directions (MMFD) chosen for the Search Method.
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G. Dependent design cases

Now we have defined the sizing settings for the normal flow case. This is
the primary design case from which we can create dependent design
cases. A dependent design case (or DDC) in the ANS module is a system
that represents the same physical pipes and junctions as the primary case,
but with different operating requirements. The dependent design case for
this model is when Burner #3 is closed. When the middle burner is
closed, the flow to each of the other burners increases to 3 kg/sec.

Here are the steps to create this Dependent Design Case:

1. Go to the Sizing Objective panel and select the "Enable Dependent
Design Cases" option. A new button will now be available for the
Dependent Design Cases panel in the Sizing Navigation Panel as
shown in Figure 4.7.

Sizing Size/Cost Candidate Design Assign Sizing
Set: Dats

Objective Assignments Requiremerts Cost Databases Method

Figure 4.7 Sizing Navigation Panel with Dependent Design
Cases enabled

2. Select the Dependent Design Cases button. You should now see
instructions displayed to create the Dependent Design Case, along
with a summary table of dependent design settings. We will need to
use the Duplicate Special tool to create the dependent design case.

Go to the Workspace and choose Select All from the Edit menu.

4. Open Duplicate Special (from the Edit menu), enter an increment of
100 and select "Make Dependent Design Case" (Figure 4.8). Click
OK.
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Duplicate Special

(] Increment All Pipe and Junction Numbers By: |100 P
[] Create Group

[ Hide in Output
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[ Clear Design Requirements

o« OK B Cance P Heb

Figure 48  Duplicate Special for creating the DDC

5. Move the duplicated pipes and junctions to distinguish them from the
original ones from the Primary Design Case (Figure 4.9).

6. Close control valve J112 in the DDC by setting the Special
Condition on the Optional tab of the Pipe Properties window to
closed.

7. Use Global Junction Edit (from the Edit menu) to change the flow
setpoint for all open control valves in the DDC (J108, J110, J114,
J116) to 3 kg/sec (Figure 4.10).

8. Inthe Sizing window navigate to the Design Requirements panel. On
the Control Valves page remove the pressure drop requirement from
J112, since this valve is closed for the DDC.
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Workspace with Primary Design Case (at top) and
one Dependent Design Case (at bottom)
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Global Junction Edit
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Figure 4.10  Global Junction Edit is used to change the control
valve setpoints to 3 kg/sec in the DDC

Return to the Dependent Design Cases panel.

When Duplicate Special was performed with Dependent Design Case
selected, each of the duplicated pipes was created with a special type of
grouping. For example, pipe 101 is grouped with pipe 1 as a DDC pipe
(see Figure 4.11). This type of assignment allows the dependent design
pipes to be sized, but to not be counted in the cost so that the cost will
not be duplicated.

It should also be noted that the dependent design grouping causes each of
the dependent pipes to inherit their Common Size Groups, Candidate
Sets, and Cost Database settings from the pipes in the primary case. The
dependent design case pipes are therefore hidden on all sizing panels
except for the Design Requirements and Dependent Design Cases panels.
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Figure 411 Pipes in Dependent Design Cases have a special
grouping relationship with pipes in the primary case

Step 4. Run the automated sizing

Select Run from the Analysis menu to perform the automated sizing.

After the run finishes, examine the final pipe sizes calculated by the ANS
module. One can see that the resultant size is 4-inch steel for the header,

with larger 5-inch steel pipe for the distribution lines, as shown in Figure
4.12.

The total cost for the pipes is $46,557 (see Cost Report in Figure 4.13).
This includes the $8,250 cost for the supply line pipes which were not
sized, as well as the $38,437 cost for the pipes in the model which were
sized, including the header and distribution piping.
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Output o x
Cddoh»E
¥ General
2 Pipes AwalPoints Heat Transfer | Sizing | Pipe Design Requirements Database Sources
Name | Sized- Sized - Sized - Type/ | Sized - Hyd. 7
(inches)

1 |NA NA NA NA NIA

2 |NA NA NA NIiA N/A

3 |Pipe Steel- ANSI 4inch STD (schedule 40) 4026

4 |Pipe Steel- ANSI 4inch STD (schedule 40) 4026

5 |Pipe Steel- ANSI 4inch STD (schedule £0) 4026

6 |[Pipe Steel- ANSI 4inch STD (schedule 40) 4026

7 |Pipe Steel- ANSI Sinch STD (schedule 40) 5.047

8 |Pipe Steel- ANSI Sinch STD (schedule 40) 5.047

9 |Pipe Steel- ANSI Sinch STD (schedule 40) 5.047

10 |Pipe  Steel-ANSI Sinch STD (schedule 40) 5.047

11 |Pipe  Steel- ANSI Sinch STD (schedule 40) 5.047

12 |Pipe  Steel- ANSI Sinch STD (schedule 40) 5.047

13 |Pipe  Steel-ANSI Sinch STD (schedule 40) 5.047

14 |Pipe Steal- ANSI Sinch STD (schedule 40) 5.047

15 |Pipe Steel- ANSI Sinch STD (schedule 40) 5047

16 |Pipe  Steel-ANSI Sinch STD (schedule 40) 5047 v

Figure 412 Resulting header and distribution pipe sizes

Step 5. Review the results

The automated sizing we just ran had two operating cases. One was for
operation when all burners are running, and the second was for the case
where one burner is shut off. The all burners case is modeled by the
network shown in the upper part of Figure 4.9. The second model shown
at the bottom of Figure 4.9 represents the four burners case.

The pipes and junctions in the four burners case are separate entities for
modeling purposes, but represent the same pipes and junctions as the all
burners case. Thus, when performing automated sizing, we only count
the cost of the pipes and junctions once. This occurs in the primary
design case, which in this model is the all burners case. This is why pipes
P101-P116 are not shown in the Cost Report.
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Output

N TN S R —
.R General  \Wamings Coisepm|\|'alveSwm Heat Exchanger Summary = Tank Summary

e Dot | Type | Name | Material | Instaitation | N°E A5 | Maintenance | Opteco” | 859700 | ToTAL
TOTAL OF ALL MODEL COSTS 46,557
| Total of All Shown Costs 28279 18278 46,557 0 ) 0 46,557
| items In Sizing 2331 15.103 38.437 0 0 0 3843
Items Not In Sizing 4,946 3174 8.120 0 0 0 8120
Pipe Subtotal 28279 18.278 46,557 [ 0 0_ 46,557
e Fipe Pipe 3297 2116 5413 0 0 0 5413
e Fipe Pipe 1,649 1,088 2.707 0 0 0 2707
o|Pa Pipe Pipe [ZEINTEE 2963 0 [ 0 298
o |Pa Pipe Pipe [R7E1 g 2963 0 0 0 293
o|Ps Pipe Pipe | 1781 1181 2963 0 0 0 2363
o |Ps Pipe Pipe [ 1781 1181 2963 0 0 0 2%3
Lo |F7 Pipe Pipe | 1962 125 3218 0 0 0 328
Lo|Ps Pipe Pipe [19280 818 209 0 0 0 209
o|Pa Pipe Pipe [L01862 1256 3218 0 0 0 328
o |P10 Pipe Pipe [12800 1818 2059 0 0 0 209
Lo|Pn Pipe Pipe | 1862 12% 3218 0 0 0o 3218
o P12 Pipe Pipe | 1280 819 2,099 0 0 0 209
o|P12 Pipe Pipe | 1862 125 3218 0 0 0 3218
Lo |P14 Pipe Pipe | 0280 818 2099 0 0 0 209
o |P15 Pipe Pipe | 1862 125 3218 0 0 0 3218
o |P16 Pipe Pipe | 1280 818 2099 0 0 0 209

Figure 4.13

Cost Report shown in the Output window

By applying different pressure and flow requirements between the two
cases, we performed an automated sizing that selected the best pipe size
which simultaneously met the requirements of both cases,

Other possibilities

To obtain the best possible design for the system, one can allow each
pipe to be sized independently by removing all pipes from the Common
Size Groups. While not shown here, it is possible to reduce the overall
cost for this system to about $41,000 by using the Genetic Algorithm
search method.

This final automated sizing takes much longer to run (a few minutes vs. a
few seconds previously). Since all the pipes are sized independently, the
practical result is that ordering and installing the pipe is more
complicated because there are so many more sizes involved.
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Alternatively, this sizing could be performed by using weight as the
objective instead of monetary cost to simplify the setup. Using a non-
monetary objective can result in reduced savings in cases where the
energy costs or costs of equipment such as compressors will make up a
significant portion of the costs. However, for this natural gas system we
are only sizing for the pipes. Though not shown here, changing the
objective to pipe weight for this example produces identical results to
those shown in Figure 4.12.



CHAPTER 5

Other AFT Arrow ANS Module
Capabilities

This Quick Start Guide necessarily omitted coverage of a number of
AFT Arrow ANS module capabilities. This chapter briefly describes
some of the important capabilities not covered.

Size with operating costs spread over multiple cases

For systems with multiple design cases, the system may operate a
significant portion of the time in each design case mode. The ANS
module allows one to assign a percentage of the operating cost to each
relevant design.

For example, assume you are designing a two-compressor air supply
system which uses both compressors in the summer but only one in the
winter. The winter operating cost is thus much less than in the summer.
You can account for this by assigning the percentage of the time the
compressor operates in each design case. This allows a proper
accounting of annual operating costs and a proper life cycle automated
sizing to be performed.

Vary recurring costs over time
Through "scale tables" the ANS module allows you to input recurring

data for pipes or junctions that vary over time. For instance, perhaps the
maintenance cost of a piece of equipment is low at first but requires
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increased maintenance over some time period. The cost for maintenance
can be varied over time to match the anticipated maintenance schedule.

Time value of money

An important consideration in evaluating recurring cost items is the cost
of money for future expenses. The ANS module allows you to enter an
interest rate and inflation rate to account for actual value of future
expenses based on today's currency value. This data is entered in the
Sizing Objective panel of the Sizing window.

Determine cost effectiveness of replacing existing pipe

The ANS module can determine the cost effectiveness of leaving existing
pipe in place or replacing it with new pipe. This can be defined on the
Size/Cost Assignments panel.

Working with different currencies

Costs vs. size

Cost data can be entered in any currency you wish. Different currencies
can be defined in the Parameter and Unit Preferences window, and then
used as a basis for cost databases.

Scale tables can be used to model how equipment costs vary with pipe
diameter. For instance, a 4-inch valve costs more than a similar 2-inch
valve. This can be accounted for in the cost database with scale tables.

Generic compressor and fan costs can be modeled as a function of
power, and generic control valve costs can be modeled as a function of
maximum Cv,

Sizing rectangular duct systems

The ANS module can size systems with only rectangular ducts or a
combination of rectangular and cylindrical ducts. Rectangular ducts have
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two space dimensions, and thus two design variables are required for
cach independent duct size.

Compare VFD vs. FCV sized systems

Variable Frequency Drive (VFD) control methods are frequently
compared to Flow Control Valve (FCV) methods. However, this is
typically only evaluated in the context of a given pipe system. The ANS
module allows one to size the system for each of these methods. This
allows a more meaningful comparison.

Maximum cost groups

Discrete costs

When evaluating multiple operating cases, one of the compressor or fan
operating modes will drive the compressor or fan selection for all cases.
This is by virtue of the fact that the cost will be based on the mode
requiring the most power. This can be modeled in the ANS module with
Maximum Cost Groups. A Maximum Cost Group allows one to couple
costs together for all compressors or fans that will eventually be of the
same design (and thus cost the same). This allows the proper cost
information to be used for each design case.

Maximum cost groups can also be used for control valves.

For sizing items such as compressor motors, a discrete cost table can be
created so that the costs will be reported based on the discrete motor
sizes available, rather than reporting an interpolated cost, which assumes
that motors are available for purchase at any capacity.

Network databases

Engineering and cost databases can be located on local PCs or deployed
across local or wide area networks. The Database Manager allows users
to connect to relevant databases for their specific pipe system design.
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